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Chapter 400

Tests for One Mean
Introduction
The one-sample t-test is used to test whether the mean of a population is greater than, less than, or not equal to a
specific value. Because the t distribution is used to calculate critical values for the test, this test is often called the
one-sample t-test. If the standard deviation is known, the normal distribution is used instead of the t distribution and
the test is officially known as the z test.
When the data are differences between paired values, this test is known as the paired t-test.
This module also calculates the power of the nonparametric analog of the t-test, the Wilcoxon test.

Test Procedure
1. Find the critical value. Assume that the true mean is M0. Choose a value Ta so that the probability of
rejecting H0 when H0 is true is equal to a specified value called α . Using the t distribution, select Ta so
that Pr(t > Ta ) = α . This value is found using a t probability table or a computer program (like PASS).

2. Select a sample of n items from the population and compute the t statistic. Call this value T. If T > Ta
reject the null hypothesis that the mean equals M0 in favor of an alternative hypothesis that the mean equals
M1 where M1 > M0.
Following is a specific example. Suppose we want to test the hypothesis that a variable, X, has a mean of 100 versus
the alternative hypothesis that the mean is greater than 100. Suppose that previous studies have shown that the
standard deviation, σ , is 40. A random sample of 100 individuals is used.
We first compute the critical value, Ta . The value of Ta that yields α = 0.05 is 106.6. If the mean computed from a
sample is greater than 106.6, reject the hypothesis that the mean is 100. Otherwise, do not reject the hypothesis. We
call the region greater than 106.6 the Rejection Region and values less than or equal to 106.6 the Acceptance Region
of the significance test.
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Now suppose that you want to compute the power of this testing procedure. In order to compute the power, we
must specify an alternative value for the mean.
We decide to compute the power if the true mean Figure 1 - Finding Alpha
were 110. Figure 2 shows how to compute the
power in this case.
The power is the probability of rejecting H0
when the true mean is 110. Since we reject H0
when the calculated mean is greater than 106.6,
the probability of a Type-II error (called β ) is
given by the dark, shaded area of the second
graph. This value is 0.196. The power is equal to
1 - β or 0.804.

Note that there are six parameters that may be
varied in this situation: two means, standard
deviation, alpha, beta, and the sample size.

Figure 2 - Finding Beta
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Assumptions
This section describes the assumptions that are made when you use one of these tests. The key assumption relates
to normality or non-normality of the data. One of the reasons for the popularity of the t-test is its robustness in the
face of assumption violation. However, if an assumption is not met even approximately, the significance levels
and the power of the t-test are invalidated. Unfortunately, in practice it often happens that several assumptions are
not met. This makes matters even worse! Hence, take the steps to check the assumptions before you make
important decisions based on these tests.

One-Sample T-Test Assumptions
The assumptions of the one-sample t-test are:
1. The data are continuous (not discrete).
2. The data follow the normal probability distribution.
3. The sample is a simple random sample from its population. Each individual in the population has an equal
probability of being selected in the sample.

Paired T-Test Assumptions
The assumptions of the paired t-test are:
1. The data are continuous (not discrete).
2. The data, i.e., the differences for the matched-pairs, follow a normal probability distribution.
3. The sample of pairs is a simple random sample from its population. Each individual in the population has
an equal probability of being selected in the sample.

Wilcoxon Signed-Rank Test Assumptions
The assumptions of the Wilcoxon signed-rank test are as follows (note that the difference is between a data value
and the hypothesized median or between the two data values of a pair):
1. The differences are continuous (not discrete).
2. The distribution of each difference is symmetric.
3. The differences are mutually independent.
4. The differences all have the same median.
5. The measurement scale is at least interval.

Limitations
There are few limitations when using these tests. Sample sizes may range from a few to several hundred. If your
data are discrete with at least five unique values, you can often ignore the continuous variable assumption.
Perhaps the greatest restriction is that your data come from a random sample of the population. If you do not have
a random sample, your significance levels will probably be incorrect.
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Technical Details
Standard Deviation Known
When the standard deviation is known, the power is calculated as follows for a directional alternative (one-tailed
test) in which M1 > M0.
1. Find zα such that 1 − Φ( zα ) = α , where Φ( x ) is the area under the standardized normal curve to the left
of x.

σ

2. Calculate: X a = M0 + z α
3. Calculate: z a =

n

.

X a - M1 .

σ

n
4. Power = 1 − Φ( za ) .

Standard Deviation Unknown
When the standard deviation is unknown, the power is calculated as follows for a directional alternative (onetailed test) in which M1 > M0.
1. Find tα such that 1 − Tdf (tα ) = α , where Tdf (tα ) is the area under a central-t curve to the left of x and df
= n - 1.
2. Calculate: xa = M0 + t α

σ
n

.

3. Calculate the noncentrality parameter: λ =

M1 − M0

σ

.

n
4. Calculate: t a =

x a - M1 + λ .

σ

n
5. Calculate: Power = 1 − Tdf′ , λ (ta ) , where Tdf′ , λ ( x ) is the area under a noncentral-t curve with degrees of
freedom df and noncentrality parameter λ to the left of x.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most
conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha error
level.
Select Power when you want to calculate the power of an experiment that has already been run.

Test
Alternative Hypothesis
This option specifies the alternative hypothesis. This implicitly specifies the direction of the hypothesis test. The
null hypothesis is always H0 : Mean0 = Mean1.
Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the
hypothesis test. Its accuracy is critical.
Possible selections are:
•

Ha: Mean0 ≠ Mean1
This is the most common selection. It yields the two-tailed t-test. Use this option when you are testing
whether the means are different but you do not want to specify beforehand which mean is larger. Many
scientific journals require two-tailed tests.

•

Ha: Mean0 < Mean1
This option yields a one-tailed t-test. Use it when you are only interested in the case in which Mean1 is
greater than Mean0.

•

Ha: Mean0 > Mean1
This options yields a one-tailed t-test. Use it when you are only interested in the case in which Mean1 is less
than Mean0.

Nonparametric Adjustment
This option makes appropriate sample size adjustments for the Wilcoxon test. Results by Al-Sunduqchi and
Guenther (1990) indicate that power calculations for the Wilcoxon test may be made using the standard t-test
formulations with a simple adjustment to the sample size. The size of the adjustment depends upon the actual
distribution of the data. They give sample size adjustment factors for four distributions. These are 1 for the
uniform distribution, 2/3 for the double exponential distribution, 9 / π 2 for the logistic distribution, and π / 3 for
the normal distribution.
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The options are as follows:
•

Ignore
Do not make a Wilcoxon adjustment. This indicates that you want to analyze a t-test, not the Wilcoxon test.

•

Uniform
Make the Wilcoxon sample size adjustment assuming the uniform distribution. Since the factor is one, this
option performs the same as Ignore. It is included for completeness.

•

Double Exponential
Make the Wilcoxon sample size adjustment assuming that the data actually follow the double exponential
distribution.

•

Logistic
Make the Wilcoxon sample size adjustment assuming that the data actually follow the logistic distribution.

•

Normal
Make the Wilcoxon sample size adjustment assuming that the data actually follow the normal distribution.

Population Size
This is the number of subjects in the population. Usually, you assume that samples are drawn from a very large
(infinite) population. Occasionally, however, situations arise in which the population of interest is of limited size.
In these cases, appropriate adjustments must be made.
When a finite population size is specified, the standard deviation is reduced according to the formula:




σ12 = 1 −

n 2
σ
N

where n is the sample size, N is the population size, σ is the original standard deviation, and σ1 is the new
standard deviation.




The quantity n/N is often called the sampling fraction. The quantity 1 −

n
 is called the finite population
N

correction factor.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study. This value
must be an integer greater than one. Note that you may enter a list of values using the syntax 50,100,150,200,250
or 50 to 250 by 50.

Effect Size – Means
Mean0 (Null or Baseline)
This option specifies one or more values of the mean corresponding to the null hypothesis. If you are analyzing a
paired t-test, this value should be zero.
Only the difference between Mean0 and Mean1 is used in the calculations.
Means1 (Alternative)
This option specifies one or more values of the mean corresponding to the alternative hypothesis. If you are
analyzing a paired t-test, this value represents the mean difference that you are interested in.
Only the difference between Mean0 and Mean1 is used in the calculations.

Effect Size – Standard Deviation
Standard Deviation
This option specifies one or more values of the standard deviation. This must be a positive value. Be sure to use
the standard deviation of X and not the standard deviation of the mean (the standard error).
When this value is not known, you must supply an estimate of it. PASS includes a special module for estimating
the standard deviation. This module may be loaded by pressing the SD button. Refer to the Standard Deviation
Estimator chapter for further details.
Known Standard Deviation
This option specifies whether the standard deviation (sigma) is known or unknown. In almost all experimental
situations, the standard deviation is not known. However, great calculation efficiencies are obtained if the
standard deviation is assumed to be known.
When this box is checked, the program performs its calculations assuming that the standard deviation is known.
This results in the use of the normal distribution in all probability calculations. Calculations using this option will
be much faster than for the unknown standard deviation case. The results for either case will be close when the
sample size is over 30.
When this box is not checked, the program assumes that the standard deviation is not known and will be estimated
from the data when the t-test is run. This results in probability calculations using the noncentral-t distribution.
This distribution requires a lot more calculations than does the normal distribution.

400-7
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for One Mean

The calculation speed comes into play whenever the Find option is set to something besides Beta. In these cases,
the program uses a special searching algorithm which requires numerous iterations. You will note a real
difference in calculation speed depending on whether this option is checked.
A reasonable strategy would be to leave this option checked while you are experimenting with the parameters and
then turn it off when you are ready for your final results.

Example 1 – Power after a Study
This example will cover the situation in which you are calculating the power of a t-test on data that have already
been collected and analyzed. For example, you might be playing the role of a reviewer, looking at the power of ttest from a study you are reviewing. In this case, you would not vary the means, standard deviation, or sample
size since they are given by the experiment. Instead, you investigate the power of the significance tests. You
might look at the impact of different alpha values on the power.
Suppose an experiment involving 100 individuals yields the following summary statistics:
Hypothesized mean (M0)
Sample mean (M1)
Sample standard deviation
Sample size

100.0
110.0
40.0
100

Given the above data, analyze the power of a t-test which tests the hypothesis that the population mean is 100
versus the alternative hypothesis that the population mean is 110. Consider the power at significance levels 0.01,
0.05, 0.10 and sample sizes 20 to 120 by 20.
Note that we have set M1 equal to the sample mean. In this case, we are studying the power of the t-test for a
mean difference the size of that found in the experimental data.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for One Mean procedure window by expanding Means, then One Mean, then clicking
on Test (Inequality), and then clicking on Tests for One Mean. You may then make the appropriate entries as
listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Ha: Mean0 ≠ Mean1
Nonparametric Adjustment ..................... Ignore
Population Size ....................................... Infinite
Alpha ....................................................... 0.01 0.05 0.10
N (Sample Size)...................................... 20 to 120 by 20
Mean0 (Null or Baseline) ........................ 100
Mean1 (Alternative) ................................ 110
S (Standard Deviation) ........................... 40
Known Standard Deviation ..................... Not checked
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Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample T-Test
Null Hypothesis: Mean0 = Mean1 Alternative Hypothesis: Mean0 ≠ Mean1
Unknown standard deviation.
Effect
Power
N
Alpha
Beta Mean0 Mean1
S
Size
0.06051
20
0.01000
0.93949
100.0
110.0
40.0
0.250
0.14435
40
0.01000
0.85565
100.0
110.0
40.0
0.250
0.24401
60
0.01000
0.75599
100.0
110.0
40.0
0.250
0.34953
80
0.01000
0.65047
100.0
110.0
40.0
0.250
0.45316 100
0.01000
0.54684
100.0
110.0
40.0
0.250
0.54958 120
0.01000
0.45042
100.0
110.0
40.0
0.250
0.18590
20
0.05000
0.81410
100.0
110.0
40.0
0.250
(report continues)
Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the size of the sample drawn from the population. To conserve resources, it should be small.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Beta is the probability of accepting a false null hypothesis. It should be small.
Mean0 is the value of the population mean under the null hypothesis. It is arbitrary.
Mean1 is the value of the population mean under the alternative hypothesis. It is relative to Mean0.
Sigma is the standard deviation of the population. It measures the variability in the population.
Effect Size, |Mean0-Mean1|/Sigma, is the relative magnitude of the effect under the alternative.
Summary Statements
A sample size of 20 achieves 6% power to detect a difference of -10.0 between the null
hypothesis mean of 100.0 and the alternative hypothesis mean of 110.0 with an estimated
standard deviation of 40.0 and with a significance level (alpha) of 0.01000 using a two-sided
one-sample t-test.

This report shows the values of each of the parameters, one scenario per row. The values of power and beta were
calculated from the other parameters.
The definitions of each column are given in the Report Definitions section.

Plots Section

These plots show the relationship between sample size and power for various values of alpha.
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Example 2 – Finding the Sample Size
This example will consider the situation in which you are planning a study that will use the one-sample t-test and
want to determine an appropriate sample size. This example is more subjective than the first because you now
have to obtain estimates of all the parameters. In the first example, these estimates were provided by the data.
In studying deaths from SIDS (Sudden Infant Death Syndrome), one hypothesis put forward is that infants dying
of SIDS weigh less than normal at birth. Suppose the average birth weight of infants is 3300 grams with a
standard deviation of 663 grams. Use an alpha of 0.05 and power of both 0.80 and 0.90. How large a sample of
SIDS infants will be needed to detect a drop in average weight of 25%? Of 10%? Of 5%? Note that applying these
percentages to the average weight of 3300 yields 2475, 2970, and 3135.
Although a one-sided hypothesis is being considered, sample size estimates will assume a two-sided alternative to
keep the research design in line with other studies.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for One Mean procedure window by expanding Means, then One Mean, then clicking
on Test (Inequality), and then clicking on Tests for One Mean. You may then make the appropriate entries as
listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Ha: Mean0 ≠ Mean1
Nonparametric Adjustment ..................... Ignore
Population Size ....................................... Infinite
Power ...................................................... 0.80 0.90
Alpha ....................................................... 0.05
Mean0 (Null or Baseline) ........................ 3300
Mean1 (Alternative) ................................ 2475 2970 3135
S (Standard Deviation) ........................... 663
Known Standard Deviation ..................... Not checked

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample T-Test
Null Hypothesis: Mean0 = Mean1 Alternative Hypothesis: Mean0 ≠ Mean1
Unknown standard deviation.
Effect
Power
N
Alpha
Beta Mean0 Mean1
S
Size
0.85339
8
0.05000
0.14661 3300.0 2475.0
663.0
1.244
0.90307
9
0.05000
0.09693 3300.0 2475.0
663.0
1.244
0.80426
34
0.05000
0.19574 3300.0 2970.0
663.0
0.498
0.90409
45
0.05000
0.09591 3300.0 2970.0
663.0
0.498
0.80105 129
0.05000
0.19895 3300.0 3135.0
663.0
0.249
0.90070 172
0.05000
0.09930 3300.0 3135.0
663.0
0.249

This report shows the values of each of the parameters, one scenario per row. Since there were three values of
Mean1 and two values of beta, there are a total of six rows in the report.
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We were solving for the sample size, N. Notice that the increase in sample size seems to be most directly related
to the difference between the two means. The difference in beta values does not seem to be as influential,
especially at the smaller sample sizes.
Note that even though we set the beta values at 0.1 and 0.2, these are not the beta values that were achieved. This
happens because N can only take on integer values. The program selects the first value of N that gives at least the
values of alpha and beta that were desired.

Example 3 – Finding the Minimum Detectable Difference
This example will consider the situation in which you want to determine how small of a difference between the
two means can be detected by the t-test with specified values of the other parameters.
Continuing with the previous example, suppose about 50 SIDS deaths occur in a particular area per year. Using
50 as the sample size, 0.05 as alpha, and 0.20 as beta, how large of a difference between the means is detectable?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for One Mean procedure window by expanding Means, then One Mean, then clicking
on Test (Inequality), and then clicking on Tests for One Mean. You may then make the appropriate entries as
listed below, or open Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Mean1 (Search<Mean0)
Alternative Hypothesis ............................ Ha: Mean0 ≠ Mean1
Nonparametric Adjustment ..................... Ignore
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
N (Sample Size)...................................... 50
Mean0 (Null or Baseline) ........................ 3300
S (Standard Deviation) ........................... 663
Known Standard Deviation ..................... Not checked

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample T-Test
Null Hypothesis: Mean0 = Mean1 Alternative Hypothesis: Mean0 ≠ Mean1
Unknown standard deviation.
Effect
Power
N
Alpha
Beta Mean0 Mean1
S
Size
0.80000
50
0.05000
0.20000 3300.0 3032.0
663.0
0.404

With a sample of 50, a difference of 3300 - 3032 = 268 would be detectable. This difference represents about an
8% decrease in weight.
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Example 4 – Paired T-Test
Usually, a researcher designs a study to compare two or more groups of subjects, so the one sample case
described in this chapter occurs infrequently. However, there is a popular research design that does lead to the
single mean test: paired observations.
For example, suppose researchers want to study the impact of an exercise program on the individual’s weight. To
do so they randomly select N individuals, weigh them, put them through the exercise program, and weigh them
again. The variable of interest is not their actual weight, but how much their weight changed.
In this design, the data are analyzed using a one-sample t-test on the differences between the paired observations.
The null hypothesis is that the average difference is zero. The alternative hypothesis is that the average difference
is some nonzero value.
To study the impact of an exercise program on weight loss, the researchers decide to conduct a study that will be
analyzed using the paired t-test. A sample of individuals will be weighed before and after a specified exercise
program that will last three months. The difference in their weights will be analyzed.
Past experiments of this type have had standard deviations in the range of 10 to 15 pounds. The researcher wants
to detect a difference of 5 pounds or more. Alpha values of 0.01 and 0.05 will be tried. Beta is set to 0.20 so that
the power is 80%. How large of a sample must the researchers take?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for One Mean procedure window by expanding Means, then One Mean, then clicking
on Test (Inequality), and then clicking on Tests for One Mean. You may then make the appropriate entries as
listed below, or open Example 4 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Ha: Mean0 ≠ Mean1
Nonparametric Adjustment ..................... Ignore
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.01 0.05
Mean0 (Null or Baseline) ........................ 0
Mean1 (Alternative) ................................ -5
S (Standard Deviation) ........................... 10 12.5 15
Known Standard Deviation ..................... Not checked
Plots Tab
X-Y-Z Plots Live Edit/Rotate ................... Checked
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots
Numeric Results for One-Sample T-Test
Null Hypothesis: Mean0 = Mean1 Alternative Hypothesis: Mean0 ≠ Mean1
Unknown standard deviation.
Effect
Power
N
Alpha
Beta Mean0 Mean1
S
Size
0.80939
51
0.01000
0.19061
0.0
-5.0
10.0
0.500
0.80778
34
0.05000
0.19222
0.0
-5.0
10.0
0.500
0.80434
77
0.01000
0.19566
0.0
-5.0
12.5
0.400
0.80779
52
0.05000
0.19221
0.0
-5.0
12.5
0.400
0.80252 109
0.01000
0.19748
0.0
-5.0
15.0
0.333
0.80230
73
0.05000
0.19770
0.0
-5.0
15.0
0.333

The report shows the values of each of the parameters, one scenario per row. We were solving for the sample size,
N.
Note that depending on our choice of assumptions, the sample size ranges from 34 to 109. Hence, the researchers
have to make a careful determination of which standard deviation and significance level should be used.
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Example 5 – Wilcoxon Test
The Wilcoxon test, a nonparametric analog of the paired comparison t-test, is recommended when the distribution
of the data is symmetrical, but not normal. A study by Al-Sunduqchi (1990) showed that sample size and power
calculations for the Wilcoxon test can be made using the standard t-test results with a simple adjustment to the
sample size.
Suppose the researchers in Example 4 want to compare sample size requirements of the t-test with those of the
Wilcoxon test. They would use the same values, only this time the Nonparametric Adjustment would be set to
double exponential. The double exponential was selected because it requires the largest adjustment of the
distributions available in PASS and they wanted to know what the largest adjustment was.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for One Mean procedure window by expanding Means, then One Mean, then clicking
on Test (Inequality), and then clicking on Tests for One Mean. You may then make the appropriate entries as
listed below, or open Example 5 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Ha: Mean0 ≠ Mean1
Nonparametric Adjustment ..................... Double Exponential
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.01 0.05
Mean0 (Null or Baseline) ........................ 0
Mean1 (Alternative) ................................ -5
S (Standard Deviation) ........................... 10 12.5 15
Known Standard Deviation ..................... Not checked
Plots Tab
X-Y-Z Plots Live Edit/Rotate ................... Checked

400-14
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for One Mean

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots
Numeric Results for Wilcoxon Test (Double Exponential Distribution)
Null Hypothesis: Mean0 = Mean1 Alternative Hypothesis: Mean0 ≠ Mean1
Unknown standard deviation.
Effect
Power
N
Alpha
Beta Mean0 Mean1
S
Size
0.80939
34
0.01000
0.19061
0.0
-5.0
10.0
0.500
0.80778
23
0.05000
0.19222
0.0
-5.0
10.0
0.500
0.81069
52
0.01000
0.18931
0.0
-5.0
12.5
0.400
0.80779
35
0.05000
0.19221
0.0
-5.0
12.5
0.400
0.80252
73
0.01000
0.19748
0.0
-5.0
15.0
0.333
0.80230
49
0.05000
0.19770
0.0
-5.0
15.0
0.333

If you compare these sample size values with those of Example 4, you will find that these are about two-thirds of
those required for the t-test. This is the value of the adjustment factor for the Wilcoxon test when the underlying
distribution is the double exponential.
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Example 6 – Validation using Zar
Zar (1984) pages 111-112 presents an example in which Mean0 = 0.0, Mean1 = 1.0, S = 1.25, alpha = 0.05, and N
= 12. Zar obtains an approximate power of 0.72.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for One Mean procedure window by expanding Means, then One Mean, then clicking
on Test (Inequality), and then clicking on Tests for One Mean. You may then make the appropriate entries as
listed below, or open Example 6 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Ha: Mean0 ≠ Mean1
Nonparametric Adjustment ..................... Ignore
Population Size ....................................... Infinite
Alpha ....................................................... 0.05
N (Sample Size)...................................... 12
Mean0 (Null or Baseline) ........................ 0
Mean1 (Alternative) ................................ 1
S (Standard Deviation) ........................... 1.25
Known Standard Deviation ..................... Not checked

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample T-Test
Null Hypothesis: Mean0 = Mean1 Alternative Hypothesis: Mean0 ≠ Mean1
Unknown standard deviation.
Effect
Power
N
Alpha
Beta Mean0 Mean1
S
Size
0.71366
12
0.05000
0.28634
0.0
1.0
1.3
0.800

The difference between the power computed by PASS of 0.71366 and the 0.72 computed by Zar is mostly due to
Zar’s use of an approximation to the noncentral t distribution.
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Example 7 – Validation using Machin
Machin, Campbell, Fayers, and Pinol (1997) page 37 presents an example in which Mean0 = 0.0, Mean1 = 0.2, S
= 1.0, alpha = 0.05, and beta = 0.20. They obtain a sample size of 199.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for One Mean procedure window by expanding Means, then One Mean, then clicking
on Test (Inequality), and then clicking on Tests for One Mean. You may then make the appropriate entries as
listed below, or open Example 7 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Ha: Mean0 ≠ Mean1
Nonparametric Adjustment ..................... Ignore
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Mean0 (Null or Baseline) ........................ 0
Mean1 (Alternative) ................................ 0.2
S (Standard Deviation) ........................... 1.0
Known Standard Deviation ..................... Not checked

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample T-Test
Null Hypothesis: Mean0 = Mean1 Alternative Hypothesis: Mean0 ≠ Mean1
Unknown standard deviation.
Effect
Power
N
Alpha
Beta Mean0 Mean1
S
Size
0.80169 199
0.05000
0.19831
0.0
0.2
1.0
0.200

The sample size of 199 matches Machin’s result.
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